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Tips and Advice for Using CSRHub Dashboards 

Getting Started 

The CSRHub Dashboard pulls data from the CSRHub sustainability metrics database, using the CSRHub 
Specification for REST Access (CSRA) application program interface.  (If you would like to know more about this 
API, you can find documentation about it on the CSRHub web site.)  Recalculating a Dashboard may require 
requesting thousands of pieces of data via the Internet. 

While Excel is a mature tool that is widely used for data aggregation and analysis, anyone who uses it knows that 
it can sometimes be slow, frustrating, or unreliable.  We have devised some simple steps that may make it easier 
to use your new Dashboard product: 

1. First download and save the Dashboard version that we send you in a safe place.  You may want to come 
back to this first version to restart your research process.  You’ll also be sure to have a good version of 
our code and formulae. 

2. You will need to be on-line to use the Dashboard.  It would be best to have a reasonably high-speed 
connection—one that will not have interruptions or a high rate of transmission errors. 

3. The Dashboard has been tested with Excel 2016, 2019, and Office 365.   To use the CSRHub Dashboards, 
you will need to have one of the newer versions of Excel (pc or Mac). 

4. Some corporate computer environments attempt to block or filter requests from desktop programs for 
web-based data.  They do this because some viruses and other malware make these types of request.  If 
you believe your environment has this type of “firewall,” please contact CSRHub support.  We have 
developed a version of our product that uses VPN technology to bypass these blockages. 

5. When you open your Dashboard, it may ask you if you wish to “enable” access to the Internet.  If you 
want to recalculate your template, you will need to allow this.  However, before doing anything, 
including permitting this access, we suggest you turn off Excel’s automatic recalculation feature.  By 
making recalculation manual, you will have more control over how often and when your Dashboard 
requests data from the CSRHub server.  To turn off recalculation: 

a.  Go to the File menu and choose “Options.” 
b. Within the Options menu, choose “Formulas.” 
c. In the “Calculation options” section, pick the radio button for Manual workbook calculation. 

(Microsoft also offers instructions on this process, here.) 

After you’ve set your sheet to manual calculation, you will need to remember to periodically click on the 
Calculate indicator (normally at the bottom left of the Excel screen) or use the F9 button (on PCs). 

6. Take a quick look at the sheets in your Dashboard.  There should be an “Enter Company Names” sheet 
where you put in the company(s) you want to research.   

7. If you experience a technical problem using your Dashboard, please contact CSRHub support. There are 
known problems with network firewalls, but we may have a workaround to suggest. 

Logging In 

https://esg.csrhub.com/api-methods
https://esg.csrhub.com/api-methods
https://esg.csrhub.com/support-request
https://support.office.microsoft.com/en-US/article/Change-formula-recalculation-iteration-or-precision-73fc7dac-91cf-4d36-86e8-67124f6bcce4?ui=en-US&rs=en-US&ad=US#bmrecalculate_a_worksheet_or_workbook_m
https://esg.csrhub.com/support-request
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You can view the data in the Dashboard and share it with others, without having a CSRHub login and 
password.  However, you will not be able to update the sheet without a valid log in and password.  After you 
purchased your Dashboard, you should have received an email from CSRHub that contained a confirmation 
link.  You must validate your email address (and your identity) by clicking on this link.  Until you do this, your 
CSRHub account is not active and you will not be able to use your Dashboard. 

Clicking on the link will take you to the CSRHub web site.  You may sometimes choose to “browse” data on 
the web site—it can be faster and easier to inspect a source, look for a competitor, or find a useful link there 
than within Excel. 

Once you have confirmed your login information and password, you are ready to start updating your 
Dashboard.  Change a company name or a date in the Dashboard, then hit enter to accept your change and 
click the Calculate indicator (or press F9).  Your Dashboard should pop up a window that asks you for your 
user id and password.  (Note that you can use either your email address or your user id in the user id slot.) 

Here are some tips and issues to be aware of, with the login process: 

A. Do not try to log in while editing a cell.  Excel will pop up the log in window, but it will not proceed to 
recalculate the whole sheet.  (Once you have successfully logged in though, you can recalculate a single 
cell as you normally would.)  If you try to log in this way and the login window does not go away, just 
click on the “x” in the corner to close the window, finish editing the cell, and try logging in again. 

B. If you start logging in and then realize you are not ready to recalculate your sheet, you can click the “x” 
and close the login box.  You can also click on “Skip Calculation.”  However, this sometimes puts Excel in 
an ambiguous state.  You may have to close your sheet (you can save it or not, as you wish), reopen it, 
and start your login process again. 

C. The first recalculation will be the longest one.  Excel needs to test all of the cells in the Dashboard and 
make sure they hold correct data.  Subsequent recalculations are generally much faster than this first 
one. 

D. You can watch the progress of your recalculation via the percentage completion indicator (bottom right 
corner of your spreadsheet window). 

 

Spreadsheet Hangs 

Most spreadsheet users have experienced a “hang”—their spreadsheet stops working and they must figure 
out how to recover as much of their work as possible.  If you feel your Dashboard has “hung” you can try to 
interrupt the operation of the macros CSRHub uses to fetch data by hitting the “Escape” key.  You will see a 
pop up window that says that “Code execution has been interrupted.”  Click on the “End” button.  You may 
see the CSRHub login popup.  If you do, you can click on the “x” or select the “Skip Calculation” button and 
you should have stopped the calculation process.  Note that you should be able to restart calculation.  
However, to do this, you may either have to change the data in a cell and accept the change (this should 
make the calculation option appear) or force a recalculation of your sheet or entire spreadsheet.  The 
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instructions for doing the latter involve pressing other keys along with the F9 key and are on Microsoft’s site 
here. 

If you cannot get your sheet to respond and you terminate it (by clicking on the corner of the program 
window or in Windows by using Task Manager) you can try to reopen the sheet and see if Excel has saved a 
working version of the Dashboard.  If it has, you may be able to recover some or all of your work. 

Entering Data 

When you enter a date into a CSRHub Dashboard, use the format “YYYY/MM/DD”.  In other words, use 
“2015/12/01” for December 2015 and not “12/1/15” or “1-12-2015”.  We have had to standardize dates in 
this way because different countries use different orders for their month and date fields.  When referring to 
a CSRHub data set, use “01” for the day of the month.  So, if you want the December 2014 data set, request 
“2014/12/01” and not “2014/12/15”.  Again, we have had to standardize this so that our users can compare 
data sets with one another, without ambiguity about which day of the month is involved. 

When you enter a company name or ticker into a CSRHub Dashboard company name cell, the system tries to 
match it to one of the companies in the CSRHub database.  For each company, CSRHub tries to obtain and 
store the ticker code (if the company is publicly traded) and as many variations of the company’s name as it 
can find. 

Unfortunately, there are often many variations and overlaps for company names.  To help with this 
problem, the Dashboard includes a data browsing tool.  At the top of your spreadsheet, you should see a 
menu item “CSRHub”.  (Some users may see this only if they look for an “Add-In” or search for this item in 
their list of possible menu items.)  This menu item has tools for searching for companies, browsing regions, 
countries, industry groups and industries, and for looking through CSRHub’s data sources and the data 
elements within those sources.  The process for using this tool is as follows: 

A. Click on the cell you want to fill with information. 
B. Click on the tool you want to use. 
C. Enter the first few letters of the item you are searching for.  You will see a list of potential matches. 
D. Adjust your input text until you see the item you want. 
E. Click on the item you want and click on the “Past into the current cell” button to past the data into the 

correct cell. 

Staying Up to Date 

CSRHub updates its information once per month. So, it is possible that we will change ratings or other data 
during the period that you are using your Dashboard.  Most CSRHub functions can be “locked” to a 
particular date (e.g., the date that you enter on the Start Here page).  Values generated by functions that are 
locked this way will not update automatically. 

However, Excel attempts to save calculation time by not updating a cell that it does not think has changed.  
Therefore, any unlocked functions may not update unless you force them to, using one of the F9 plus other 
key combinations we mentioned above. 

https://support.office.microsoft.com/en-US/article/Change-formula-recalculation-iteration-or-precision-73fc7dac-91cf-4d36-86e8-67124f6bcce4?ui=en-US&rs=en-US&ad=US#bmrecalculate_a_worksheet_or_workbook_m
https://support.office.microsoft.com/en-US/article/Change-formula-recalculation-iteration-or-precision-73fc7dac-91cf-4d36-86e8-67124f6bcce4?ui=en-US&rs=en-US&ad=US#bmrecalculate_a_worksheet_or_workbook_m
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Protected Sheets 

There are a lot of formulae in your Dashboard.  If you click on a cell by mistake and erase one, you may 
affect a number of sheets and end up unsatisfied with the product.  To help avoid this problem, CSRHub has 
protected the sheets in your Dashboard with a password.  There are a few cells where you can enter data 
and values (highlighted in orange).  If you try to change other cells, Excel will warn you that it cannot do this 
unless you enter a password. 

If you decide you want to change a sheet, you can unprotect any or all of the sheets in a Dashboard.  From 
menu item Home, go to menu item Format and select “Protect sheet.”  The Dashboard will ask for the 
protection password.  It is “csrhub” (all lower case).  Enter this password and your sheet will be unlocked. 

If you ever make a mistake and damage your Dashboard, you can always download it again from the CSRHub 
web site.  Log into the CSRHub site, click on your user ID (at the top right corner of the web site) and look for 
a tab called “My downloads”.  You will find a link to your Dashboard here.  Click on the link and a fresh copy 
will download. 

Protecting Your Work 

As suggested above, it makes sense to save your Dashboard to a local drive and run it from there.  When 
you’ve updated your Dashboard, save the result in a new place—this will keep your original version intact 
and available if you want to start over.  Save frequently—Excel does crash and the Dashboard code puts a 
load on it that may make it crash more often. 

Your Dashboard includes a certain number of days of access.  At the end of your access period, you’ll get an 
email that warns you that your access period is ending.  This email will tell you how you can extend your 
access period, if you need to. 

When Your Access Period Ends 

After your access period ends, you can still view the data in your Dashboard.  However, you cannot 
recalculate the Dashboard.  If you try to do this, your sheet will replace your data with error 
messages.  Don’t save this version of your sheet—you’ll be replacing good data with errors.  If you do save 
by mistake, Excel will normally save your old version.  Go to the File menu and look at the “Manage 
Versions” area.  You should be able to return to the original version of your Dashboard that had your valid 
values. 

 

 

 

Printing 
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CSRHub has tried to set up each Dashboard sheet so that it will print at a visible size on the minimum 
number of sheets of standard-size paper.  Excel 2010 includes a feature that allows you to print directly to a 
PDF format.  Our instructions in the Print and Support sheet cover how to do this. 

Adding More Functions 

If you wish, you can create your own analysis sheets.  The process for this is as follows: 

A. Add a new sheet to your Dashboard.  (The easiest way to do this is to click on the small add a sheet icon 
to the right of the Print and Support sheet tab at the bottom of the program.) 

B. This new sheet will automatically be unprotected.  Enter “=CSRHub” in any blank cell and a list of the 
available CSRHub functions will appear. 

C. Select the function you wish to use and enter the parameters for that function. 

A full list of the functions available for the Dashboard and the parameters that may be used with them is 
available from CSRHub support or from the CSRHub Widget and API web site area. 

Updating the Dashboard Code 

From time to time, CSRHub may need to update the code in its Dashboards.  You can see which version of 
our code was used to create your Dashboard and what the current (most recent) version is of our code on 
the Print and Support sheet (Cells H7 to K9).  You can then update your code to a new version using this 
page. 

Background information 

If you want to know more about our data source, how we generate ratings, or how best to use our data, you 
will find more information on the CSRHub web site.  In particular, you may want so see: 

Our ratings methodology. 
Our data schema. 
Frequently Asked Questions 
About Special Issues 
Countries Covered 
Data Sources Covered 
Industries Covered 

https://www.csrhub.com/improve_sustainability/update-your-csrhub-dashboard-code
https://www.csrhub.com/improve_sustainability/update-your-csrhub-dashboard-code
https://www.csrhub.com/content/csrhub-ratings-methodology/
https://www.csrhub.com/content/csrhub-data-schema
https://www.csrhub.com/content/frequently-asked-questions-about-csr/
https://www.csrhub.com/content/more-about-special-issues/
https://www.csrhub.com/CSR_ratings_by_region_and_country/
http://www.csrhub.com/CSR_data_source_ratings/
http://www.csrhub.com/CSR_industry_ratings/

